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WeatherProducer offers a set of drawing tools that allow you to include text, 
icons, lines, fronts, troughs, and polygons in any annotation product or in an 
annotation layer of a composite product. (By default, new composite products 
contain one annotation layer).

Accessing annotations

To add and/or access annotations associated with the annotation layer of a 
composite establish the annotation layer as the active layer. To do this select 
Layer Controls from the view window View menu. The Layer Controls window 
will display. If not already enabled, enable the button in the Active column 
associated with the annotation layer to establish the annotation layer as the 
active layer.

Figure 1: Sample Layer Controls window

NOTE: Annotation products have no layer control. The annotation 
layer is the only layer.
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Adding annotation objects

To add one or more annotations, open the view window (of the annotation 
product or of the composite product with the annotation layer set to active) 
and make your selection(s) from the Edit menu Add New Object menu. 

Figure 2: Adding annotations

View window Edit menu

Add New Object window
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There are many types of annotations to choose. Some are illustrated in Figure 
3.

Figure 3: Some object types

Choose Library from the Add New Object menu to select a pre-defined anno-
tation object (and associated attributes) from the annotation object library. 
Place the object in the product by positioning the cursor in the view window 
and clicking the left mouse button. Refer to the appropriate discussion below 
for instructions on how to add the annotation selected. Use the Save Selected 
Object selection on the Edit menu to save the currently selected object to the 
annotation object library.

Use the Clear Layer selection on the Edit menu to clear all annotations from 
the view window of the annotation product or from the active annotation layer 
of a composite product. 

Add text

You may insert text anywhere on your graphic. To insert text:

1. Select the Text  button from the view window Edit menu Add New Object 
window.
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2. Position the mouse pointer in the view window on the location where you 
wish to place text. Click the left mouse button.

Figure 4: Annotation layer text string and Text Attributes window

The text object will appear in the position indicated. To move the object to 
a new location, drag-and-drop it using the left mouse button. 

3. Select Text Attributes from the view window Edit menu and modify the any 
of the text parameters displayed in the Text Attributes window: 
• Enter a text string in the text box
• Change the size of the text using the Scale slider
• Alter the angle of the text using the Tilt Angle slider
• Change the font using the font drop-down menu
• Change the alignment of the text using the Justify drop-down menus

Some text attributes are manipulated from the Graphic Attributes window, 
such as color and drop shadow. 

4. Click the Apply button to implement your changes.

Layer labels. Use text annotations to create descriptive labels for any prod-
uct with an annotation layer. Through a set of meta-text strings you can add 
labels that show product information such as date, time, data source, data 
time, parameter, and forecast period.

NOTE: Layer Labels are annotation objects. They cannot be saved 
with the product, and must be saved as snapshots or to the 
annotaion library. Refer to “Saving annotations” on page22 
for more information.

Text string

Text Attributes window
Annotations



5

Figure 5: Composite image with layer labels 

To add a layer label to a product:

1. Add a text object to the product using the procedure on pa ge3. 

2. Select the text object, and select Text Attributes from the view window 
Edit menu.

3. If necessary, modify the parameters displayed in the Text Attributes 
window to set a font, text size, or justification.

4. Type meta-text strings (see Table 1) in the text entry box to add labels to 
the product. Note that:

• Use regular text to create more descriptive strings. 
For example: Type: These conditions updated at $L$H:$I to dis-
play: These conditions updated at 11:30.

• When adding a time label, use one of the meta-text strings that select 
the format of the time ($C, $G, $L, $t, or $v) listed in Table 2 on 
page 7. These characters select the internal clock time to use, and do 
not display.
$G and $L specifies either GMT or local time, respectively. $t speci-
fies product data time. $v specifies product valid time. $C specifies 
the use of the current (clock) time. For examples, the string $C $H:$I 
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would display the current clock time in hour and minute format; the 
string $G$t$H:$M would display the product data time in hour and 
minute format using GMT time. 

• To specify a label for a particular product layer use the $l (lowercase 
L) string, for example $l2 accesses information for the second layer of 
a composite. To access the layers of nested composites, use relative 
numbering,   such as $l3:2. The first digit (3) specifies the layer in the 
composite; the second digit (2) specifies the second layer in the 
nested composite.

Table 1: Layer label meta strings and their definitions

Meta 
Text

Definition Displays

$H Displays current two digit hour of the day. 00 - 23

$I Displays current two digit minute of the hour. 00 - 59

$D Displays two digit day of the month. 01 - 31

$M Displays two digit month. 01 - 12

$m Displays abbreviated text month. Jan - Dec

$Y Displays four digit year. 1998

$y Displays two digit year. 98

$n Displays name of product in the specified layer. Lightning plot

$source Displays name of data source for the specified layer. 18z Meso ETA Grid 

$p Displays forecast period for the specified layer.1 0,6,12,18

$a Displays atmosphere for the specified layer.1 Tropopause, 850

$measure Displays specified parameter for the specified layer.1 Temp, Pressure
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Time modifiers.  Use these characters when adding time to a label to select 
a specific time value. For example, layer labels can display the current clock 
time or the valid time of the data in a product. Thse characters do not display, 
and must be used with a time meta character, such as $H, $I, $D, $M, or $Y. 
See the examples below.

Examples. The following are examples of meta-strings used to create layer 
labels.

This string adds a label showing the product valid time in GMT.

String: $v$G$H:$IZ $D$m
Displays: 12:00Z 22Jun
Meta text: $v -- sets the internal time to show the valid time of the prod-
uct

$G -- sets the internal time to GMT
$H -- adds the hour to the label
$I -- add the minute to the label
Z -- adds the character Z to the label
$D -- adds the day of the month to the label
$m -- adds the month (abbreviated) to the label

Table 2: Layer label time modifiers

Meta Text Description

$v Selects valid time for the specified layer.a 

a.These options, valid for gridded products only.

$issue Selects a grid issue (base) time1

$C Selects current clock time. 

$G Selects GMT (the default setting).

$L Selects local time.

$t Selects product data time.

$l Selects layer to display information. l2 displays the data for the second layer; 
l3 displays the data for the third layer. l2:1 displays layer 1 within layer 2 of a 
nested composite.
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Figure 6: Sample layer label

This string adds a label showing the current local time and product name.

String: Lightning Plot $C$L$H:$IA $M/$D/$Y
Displays: Lightning Plot 10:30A 5/12/2002
Meta Text: Lightning Plot -- add the text string to the label.

$C -- sets the internal time to show the current clock time
$L -- sets the internal time to the local time zone
$H -- adds the hour to the label
$I -- add the minute to the label
A -- adds the character A to the label (to indicate AM)
$D -- adds the day of the month to the label
$M -- adds the month (in digits) to the label
$Y -- adds the year (in digits) to the label

Figure 7: Sample layer label

This string adds a label showing the valid time and data source of the product 
on a specific layer in a composite.
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String: $l1$v$H:$I $D-$m Forecast = $p Parameter=$measure
Displays: 12:00 22-Jun Forecast 12.0 hr Parameter = Air Temperature
Meta Text: $l1 (Dollar lowercase L digit 1) -- selects the layer in the composite

$v -- sets the internal time to show the valid time of the product on the speci-
fied layer

$H -- adds the hour to the label
$I -- add the minute to the label
$D -- adds the day of the month to the label
$m -- adds the month (abbreviated) to the label
Forecast =  -- adds the text Forecast = to the label
$p-- adds the forecast period of the product on the specified layer
Parameter =  -- adds the text Parameter = to the label
$measure -- add the parameter of the product on the specified layer
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Add geoshields

A geoshield object is a single object with an editable text string and a select-
able icon (see Figure 3).You may insert one or more geoshields anywhere on 
your graphic. To insert a geoshield:

1. Open the View menu Edit menu Icon Book window (see Figure 8).

2. Select one of the available icons. Note that there are multiple pages to 
choose from. Use the scroll bars, the left and right arrow buttons, and the 
Icon Page selection menu to locate the appropriate icon.

3. Select the Geoshield button from the Add New Object window.

4. Position the mouse pointer in the appropriate location on your graphic 
and click the left mouse button. The icon and text string will appear in the 
position indicated. 

5. Select Text Attributes from the view window Edit menu and modify the any 
of the text parameters displayed in the Text Attributes window: 
• Enter a text string in the text box
• Change the size of the text using the Scale slider
• Alter the angle of the text using the Tilt Angle slider
• Change the font using the font drop-down menu
• Change the alignment of the text using the Justify drop-down menus

Some text attributes are manipulated from the Graphic Attributes window, 
such as color and drop shadow. 

6. Click Apply to apply the changes.

To move the icon to a new location, drag-and-drop it using the left mouse but-
ton. 

Close the Icon Book window when you are satisfied with your icons.
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Add icons

You may insert one or more icons anywhere on your graphic. To insert an 
icon:

1. Open the View menu Edit menu Icon Book window.

Figure 8: Icon book window

2. Select one of the available icons. Note that there are multiple pages to 
choose from. Use the scroll bars, the left and right arrow buttons, and the 
Icon Page selection menu to locate the appropriate icon.

3. Select the Icon button from the Add New Object window.

4. Position the mouse pointer in the appropriate location on your graphic 
and click the left mouse button.

To move the icon to a new location, drag-and-drop it using the left mouse but-
ton. 

Close the Icon Book window when you are satisfied with your icons.

Icon Page Selection 

Left and right arrow buttons

Scroll bars
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Add lines (curves)

You may insert one or more lines (curves) anywhere on your graphic. Note 
that a line can consist of one or more segments. To insert a line:

1. Select the Line button from the Add New Object window.

2. Position the mouse pointer in the appropriate location on your graphic 
and click the left mouse button to indicate the start-of-line. 

3. Move the mouse pointer to a second position and click the left mouse 
button again to indicate the end of the line segment. 

4. Continue adding line segments until you have completed your line then 
double-click to indicate end-of-line.

Figure 9: Anatomy of a line object

The line will appear in the position indicated. To move the line to a new loca-
tion select the line object then drag-and-drop it using the left mouse button. To 
adjust the shape of the line select one of the grab points and drag it to a new 
location. The attached line segments will stretch as you drag the grab point 
indicating any adjustments you make to the line. To add a new grab point, 
hold down the Ctrl key and click the line where the point is to be added.

To smooth the line, which replaces angles with curves, select Graphic 
Attributes from the view window Edit menu and click the Smooth box. There 
must be at least three grab points in the line in order for smoothing to take 
effect. 

Figure 10: Sample smoothed line and non-smoothed line
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Add polygons

You may insert one or more polygons anywhere on your graphic. Note that a 
polygon is created from multiple line segments. To insert a polygon:

1. Select the Polygon button from the Add New Object window.

2. Position the mouse pointer in the appropriate location on your graphic 
and click the left mouse button to indicate the start point. 

3. Move the mouse pointer to a second position and click the left mouse 
button again to indicate the end of the line segment. 

4. Continue adding line segments until you have completed your polygon 
then double-click to indicate end-of-polygon.

Figure 11: Anatomy of a polygon object

The polygon will appear in the position defined by your mouse clicks. To move 
the polygon to a new location select the polygon object then drag-and-drop it 
using the left mouse button. To adjust the shape of the polygon select one of 
the grab points and drag it to a new location. The associated polygon line seg-
ments will stretch as you drag the grab point indicating any adjustments you 
make to the polygon. To add a new grab point, hold down the Ctrl key and 
click the polygon where the point is to be added.

Add fronts

You may insert one or more fronts of various kinds anywhere on your graphic. 
Note that, like a line, a front is created from multiple line segments. 
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Figure 12: Front types

To draw a front:

1. Select a front type button from the Add New Object window (see Figure 
12).

2. Position the mouse pointer in the appropriate location on your graphic 
and click the left mouse button to indicate the start-of-front. 

3. Move the mouse pointer to a second position and click the left mouse 
button again to indicate the end of the front segment. 

4. Continue adding line segments until you have completed your front then 
double-click to indicate end-of-front.

Figure 13: Anatomy of a front object
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The front will appear in the position defined by your mouse clicks and the 
direction of the front is determined by the relationship of the mouse clicks to 
one another. A front that is drawn from:

• Left to right faces up
• Right to left faces down
• Top to bottom faces right
• Bottom to top faces left

The direction of the pips in a stationary front is also determined by the direc-
tion the front is drawn. A stationary front that is drawn:

• Left to right has warm pips facing down, cold pips facing up
• Right to left has warm pips facing up, cold pips facing down
• Top to bottom has warm pips facing left, cold pips facing right
• Bottom to top has warm pips facing right, cold pips facing left

To move the front to a new location select the front object then drag-and-drop 
it using the left mouse button. To adjust the shape of the front select one of 
the grab points and drag it to a new location. The attached line segments will 
stretch as you drag the grab point indicating any adjustments you make to the 
front. To add a new grab point, hold down the Ctrl key and click the front 
where the point is to be added.

To smooth the front, which replaces angles with curves, select Graphic 
Attributes from the view window Edit menu and click the Smooth box. There 
must be at least three grab points in the front for smoothing to take effect. For 
instructions on how to modify various attributes of the front refer to “Change 
front and trough attributes” on page19. 
WeatherProducer



16
Add troughs

You may insert one or more troughs anywhere on your graphic. Note that a 
trough is similar to a line in that it can consist of one or more segments. To 
insert a trough:

1. Select the Trough  button from the Add New Object window.

2. Position the mouse pointer in the appropriate location on your graphic 
and click the left mouse button to indicate the start-of-trough. 

3. Move the mouse pointer to a second position and click the left mouse 
button again to indicate the end of the trough segment.

4. Continue adding trough segments until you have completed your trough 
then double-click to indicate end-of-trough.

Figure 14: Anatomy of a trough

The trough will appear in the position indicated. To move the trough to a new 
location select the trough object then drag-and-drop it using the left mouse 
button. To adjust the shape of the trough select one of the grab points and 
drag it to a new location. The attached line segments will stretch as you drag 
the grab point indicating any adjustments you make to the trough. To add a 
new grab point, hold down the Ctrl key and click the trough where the point is 
to be added.

For instructions on how to modify various attributes of the trough see “Change 
front and trough attributes” on page19. 
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Add squall lines

You may insert one or more squall lines anywhere on your graphic. Similar to 
a line object, a squall line can consist of one or more segments. To insert a 
squall line:

1. Select the Squall Line button from the Add New Object window.

2. Position the mouse pointer in the appropriate location on your graphic 
and click the left mouse button to indicate the start-of-line. 

3. Move the mouse pointer to a second position and click the left mouse 
button again to indicate the end of the line segment. 

4. Continue adding line segments until you have completed your line then 
double-click to indicate end-of-line.

Figure 15: Anatomy of a squall line object

The squall line will appear in the position indicated. To move the squall line to 
a new location select the line then drag-and-drop it using the left mouse but-
ton. To adjust the shape of the squall line select one of the grab points and 
drag it to a new location. The attached line segments will stretch as you drag 
the grab point indicating any adjustments you make to the line. To add a new 
grab point, hold down the Ctrl key and click the squall line where the point is 
to be added.
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Changing annotation attributes

Every annotation object has a set of default attributes. The attributes of many 
of these components can be manipulated through an associated attribute win-
dow. These windows are accessed using the view window Edit menu (see 
Figure 2).

Change graphic attributes

Adjust the settings in the Graphic Attributes window to alter the attributes of 
your annotation object by selecting the view window Edit menu Graphic 
Attributes menu option. Use the graphic attribute window to change the color, 
lines, opacity, and other features of the graphic object. See “Graphic 
attributes” on page 39 for more information.

Change text attributes

Adjust the settings in the text attributes window to alter the font, size, justifica-
tion, or tilt of your annotation text objects. Select the view window Edit menu 
Text Attributes menu option to open the text attributes window.

Bevel, quality, outline and shadow attributes for text annotations are con-
trolled from the Graphics Attribute window (see “Change graphic attributes” ).
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Change front and trough attributes

Front and trough objects have their own editing tool, the view window Edit 
menu Front Attributes menu option. Use the Graphics Attribute window to add 
a drop shadow to the fronts or troughs (see “Change graphic attributes” ).

Figure 16: Front attributes window

Select the front or trough object you wish to modify, make the necessary 
adjustments in the front attribute window, then apply the changes by clicking 
on the Apply button in the front attribute window.
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Type buttons

Color Mixer Window
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Note that the type of object selected is indicated by the buttons across the top 
of the front attributes window. Only one of these buttons can be selected.

To change the object type, select one of the other type buttons.

To change the color of the object click on the type button. This brings up the 
color mixer window. Refer to the discussion “Color mixer” on page 29 for more 
information on colors.

By default, front and trough objects are displayed filled. To change the 
appearance of your object select the Outline box and deselect the Filled box.

Figure 17: Some front and trough attributes

The attributes in Figure 17 can be modified by adjusting the slide bar associ-
ated with the attribute type indicated.These attributes include:

Front width. Front width is the line thickness of the front or trough. The range 
is from 1-12 pixels. The default is 6 pixels.

Outline width. Outline width is the width of the line used to outline a front or 
trough object. The range is 0-20 pixels. The default is 2. If the outline width is 
set too high the object may appear filled.

Figure 18: Outline versus filled

Segment length. Front and trough objects are made up of multiple segments 
of equal length. The established length is determined by the value associated 
with the attribute Segment Length. In the case of front objects, each segment 
contains one pip around which segment length is centered. A segment may 
be from 30 to 90 pixels long. The default length is 60 pixels.
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Opacity. Opacity establishes how transparent or opaque the selected object 
will appear on the graphic. The range is 0% (completely transparent) to 100% 
(completely opaque). For non-true color systems, the settings are limited to 
0%, 25%, 50%, 75%, and 100%; attribute assignments which do not match 
any of these settings reflect the opacity of the setting closest to the number 
used.

Pip width. Pip width establishes the standard width of each pip associated 
with a front. The range is 10 to 30 pixels. The default is 20 pixels. Pip width 
should be proportionate to segment length.

Dissipating gap. Dissipating gap is the amount of space between segments 
of a dissipating front. The range is 5 to 20 pixels. The default is 20.

Change drawing priority

Establish the position of layered annotation objects using the view window 
Edit menu Drawing Priority menu option.

Figure 19: Drawing priority options

Select the annotation object then highlight one of the selections offered on the 
Drawing Priority menu. Selection offerings include:

Raise. Raise moves the object up one layer (useful when you have more than 
two layered objects).

To Top. To Top moves the object to the foreground.

Lower. Lower moves the object down one layer (useful when you have more 
than two layered objects). 

To Bottom. To Bottom moves the object underneath all other objects in the 
stack.

View window Edit menu
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Object positioning can be adjusted and readjusted at any time.

Copying annotation objects

To copy an annotation, select the annotation object and choose Copy 
Selected from the view window Edit menu. The copied object will be attached 
to the cursor, allowing you to place the object. Move the cursor and click to 
place the copied object.

Copying line objects. When copying line object (fronts, troughs, or squall 
lines), the system copies only the color and line segment attributes, and not 
the actual line. You will need to replot the line by clicking the cursor at the start 
point and any intermediate points. Double-click the cursor at the end of the 
line. See “Add lines (curves)” on page12 for more information on plotting 
lines.

Saving annotations

Annotations in the annotation layer will be retained during the current viewing 
session even if the product is updated. They cannot, however, be saved as 
part of the product. 

Annotations can be saved separately either as a snapshot of all the anno-
taions in a given layer, or individually to the annotaion library. Another method 
for saving annotaions is to create a stand alone annotation product. 

Save all annotations in a layer

To save all the annotations with a product, use the Layer Controls window 
Save option to save the annotation layer as a snapshot. Then add the snap-
shot to the product as a layer. All the annotations in the snapshot can then be 
saved with the product, or added to other products.
Annotations
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Access the Layer Controls window by selecting Layer Controls from the view 
window View menu. Click the Annotation Layer Save button and type a name 
for the snapshot in the Save Snapshot window that opens.

Figure 20: Saving annotations as a snapshot

Save individual annotations

To save a particular annotation, select the annotation and select Save 
Selected Annotation from the view window edit menu. In the Save Object win-
dow type a name for the object. The object is then saved to the Annotation 
Library where it can be added to any product with an annotation layer.

Figure 21: Save object window
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Save annotations as a product

Use the desktop New menu to create a stand alone annotation. Place annota-
tions in the product and save the product. Annotation products can be added 
to a product as a layer in a composite. 

Removing annotation objects

There are two methods to remove annotation objects: deleting a specific 
object or clearing all objects on a particular annotation layer.

Delete selected objects

To delete a specific annotation, select the annotation object and choose 
Delete Selected from the view window Edit menu (see Figure 2).

Clear annotation layer

To remove all annotations from a specific annotation layer, select Clear Layer 
from the view window Edit menu (see Figure 2). All annotations on the layer 
are removed.
Annotations


	Annotations
	Accessing annotations
	Adding annotation objects
	Add text
	Add geoshields
	Add icons
	Add lines (curves)
	Add polygons
	Add fronts
	Add troughs
	Add squall lines

	Changing annotation attributes
	Change graphic attributes
	Change text attributes
	Change front and trough attributes
	Change drawing priority

	Copying annotation objects
	Saving annotations
	Save all annotations in a layer
	Save individual annotations
	Save annotations as a product

	Removing annotation objects
	Delete selected objects
	Clear annotation layer



